[image: ]
[image: ]
[footnoteRef:1] [1: This paragraph of the first footnote will contain the date on which you submitted your paper for review. It will also contain support information, including sponsor and financial support acknowledgment. For example, “This work was supported in part by the U.S. Department of Commerce under Grant BS123456.” 
The next few paragraphs should contain the authors’ current affiliations, including current address and e-mail. For example, F. A. Author is with the National Institute of Standards and Technology, Boulder, CO 80305 USA (e-mail: author@ boulder.nist.gov). 
S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA. He is now with the Department of Physics, Colorado State University, Fort Collins, CO 80523 USA (e-mail: author@lamar.colostate.edu).
T. C. Author is with the Electrical Engineering Department, University of Colorado, Boulder, CO 80309 USA, on leave from the National Research Institute for Metals, Tsukuba, Japan (e-mail: author@nrim.go.jp).] 
[image: ]
Publication Process of 4 page Letter. (Visual Summary)
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Abstract—These instructions give you guidelines for preparing manuscripts for the IEEE Letters on Electromagnetic Compatibility Practice and Applications (L-EMCPA). Use this document as a template if you are using Microsoft Word. Otherwise, use this document just for helpful information, and prepare your paper using any word processor. The Word template is useful for estimating the length of an article (up to 3½ pages of text plus an additional ½ page for references only will be allowed – total paper length not to exceed 4 pages). If you do not use the template, 4 journal pages have a total of about 3600 words; each figure is equivalent to about 140 words. The electronic file of your paper will be formatted further at IEEE. Paper titles should be written in uppercase and lowercase letters, not all uppercase. Avoid writing long formulas with subscripts in the title; short formulas that identify the elements are fine (e.g., "Nd–Fe–B"). Full names of authors are preferred in the author field, but are not required. Put a space between authors’ initials. The abstract must be a concise yet comprehensive reflection of what is in your article. In particular, the abstract must be self-contained, without abbreviations, footnotes, or references. It should be a microcosm of the full article. The abstract must be between 150–250 words. The abstract must be written as one paragraph, and should not contain displayed mathematical equations or tabular material. 

[bookmark: PointTmp]Index Terms—Enter three to six key words or phrases in alphabetical order, separated by commas. For a list of suggested keywords, send a blank e-mail to keywords@ieee.org or visit http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt
Take-Home Messages: 
(up to seven items)
· What are the innovative features of utilizing electromagnetic compatibility practice and applications in this manuscript, in one sentence?
· What is the conclusion in this manuscript, in one sentence?
· What are the targeted EMC applications, in one sentence?
· What is the significance/breakthrough of this work?
· Accomplishments in this manuscript you would like to highlight that are not mention above, for our readers, in one sentence?
· …
· …

INTRODUCTION
This document is a Microsoft Word template for IEEE Letters on Electromagnetic Compatibility Practice and Applications (L-EMCPA). Use of this document as a template is optional. If you are reading a paper version of this document, please download the electronic Manuscript Template, from http://emcs.org/assets/documents/L-EMCPA_Template_V2.docx so you can use it to prepare your manuscript. If you would prefer to use LaTeX, download IEEE’s LaTeX style and sample files from the same Web page (currently under construction). 
When you open L-EMCPA_Template_V2.docx, select “Print Layout” from the “View” menu in the menu bar (View > Print Layout). Then type over sections of the document or cut and paste from another document and then use markup styles (Home > Styles). For example, the style at this point in the document is “Text L-EMCPA”). Highlight a section that you want to designate with a certain style; then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Use italics for emphasis; do not underline. The font used for the text L_EMCPA is Times Roman.
Even though a Letter is limited to 4 pages of text, please use up to two levels of section headings, which will improve the readability of most articles. 
To insert images in Word, position the cursor at the insertion point and either use Insert > Picture or copy the image to the Windows clipboard and then Home > Paste. IEEE will do the final formatting of your paper, so do not worry about precisely positioning figures and tables. If you have a question about formatting your paper, or a suggestion on improving these instructions, please contact sabath@geml.uni-hannover.de.
PROCEDURE FOR PAPER SUBMISSION
ScholarOne® Manuscripts
Contributions to L-EMCPA must be submitted electronically on IEEE’s on-line manuscript submission and peer-review system, ScholarOne® Manuscripts, at https://mc.manuscriptcentral.com/l-emcpa-ieee. First check if you have an existing account. If there is none, please create a new account. (Please note that IEEE Transactions on EMC and IEEE Letters on EMC Practice and Applications use separate login credentials. Please set-up an account for IEEE Letters on EMC Practice and Applications even if you have one for IEEE Transactions on EMC) After logging in, go to your Author Center and click “Start a New Submission”. 
Along with other information, you will be asked to select the subject (“Type”) from a list of four choices (i) Abstract Reviewed Letter, (ii) Application Letter, (iii) Invited Review Article or (iv) Special Session Letter. There are 7 steps to the submission process; you must complete all 7 for a complete submission. At the end of each step you must click “Save and Continue”; just uploading the paper is not sufficient. After step 7 you should see a confirmation that the submission is complete. You should also receive an e-mail confirmation. For inquiries regarding the submission of your paper on ScholarOne® Manuscripts, please contact oprs-support@ieee.org  or call +1 732 465 5861.
ScholarOne® Manuscripts will accept files for review in the following formats: DOC, DOCX, RTF, PS, or PDF. PDF is preferred at the review stage. If you use LaTeX to prepare your document, you must generate a PDF or PS file to upload to ScholarOne® Manuscripts. Whatever format you upload, your figures should be embedded in the file.
You will be asked to file an electronic copyright form during the submission process. (Authors are responsible for obtaining any security clearances.) You will also have the opportunity to designate your article as “open access” in perpetuity if you agree to pay the IEEE open access fee.
Final Submission
After your paper is accepted, you will be asked to upload final files to ScholarOne® Manuscripts. These will include your DOC, DOCX, RTF, or LaTeX document source file with embedded figures; an additional PS or PDF file if your source is LaTeX; and separate, individual figure files. These individual files may be in any of the following formats: TIF (preferred), PDF (preferred), JPG, GIF, EPS, DOC or DOCX (especially good for tables), or PPT (commonly used to make figures). Please convert your DOC or DOCX tables and PPT figures to PDF. Figure and table files should be named following this convention: FIG1.TIF, FIG2.PPT, FIG3.PDF, etc.
Designate the author who submitted the manuscript on ScholarOne® Manuscripts as the “corresponding author.” This is the only author to whom proofs of the paper will be sent.
ORCID Instructions
All IEEE journals require an Open Researcher and Contributor ID (ORCID) for all authors. ORCIDs enable accurate attribution and improved discoverability of an author’s published work. The corresponding author will need a registered ORCID in order to submit a manuscript or review a proof in this journal. Follow these steps to link a ScholarOne account to a registered ORCID:
Login to ScholarOne and click on your name in the top right corner of the screen.
Click E-mail/Name in the dropdown menu.
In the ORCID section at the top of the page, click the appropriate link to either register for a new ORCID or associate the account with an existing ORCID.
A new page will open to create and/or validate your ORCID. Once the validation is complete, the new page will close and you will return to ScholarOne.
Save the changes to your ScholarOne user account. Authors who do not have an ORCID in their ScholarOne user account will be prompted to provide one during submission.
Publication
When the files for your accepted manuscript are all uploaded and checked by the L-EMCPA editorial office, your paper will be sent to IEEE, where it will be posted as a preprint on IEEE’s Xplore® platform, which will represent official publication. Thus, your final submitted manuscript should be a version you would like people to read. PDF page proofs will be sent by e-mail to the corresponding author in 2 to 3 weeks. The typeset article, with its article number, should appear on Xplore® a few days after the author approves the proofs.
Visual Summary
The L-EMCPA requires that on the first page a visual summary of the letter is shown. The visual summary summarizes your manuscript visually with a graphical abstract to capture your reader’s attention. A graphical abstract is a concise, illustrative reflection of the content of your article; it can be an image, a video, an audio file, or a PowerPoint file. The visual summary should highlight the main point of your article and include a caption describing the image. A visual summary must undergo peer review along with the rest of your article. Be sure to upload it during manuscript submission. 
Image specifications:
Dimensions: 10 cm x 15 cm
File types: JPG, TIF, PNG, GIF, DOC, DOCX, PDF, PS, EPS, or BMP
[bookmark: _GoBack]Recommended file size: <50 KB
Take-Home-Messages
In order to provide readers with a quick overview on the main technical content the L-EMCPA shows a box with Take-Home-Messages. The Take-Home-Messages are up to seven bullet points summarizing the innovative features of utilizing electromagnetic compatibility practice and applications in this manuscript. Be sure to show the Take-Home-Message box on the first page and upload it during manuscript submission.
HELPFUL HINTS 
Units
Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary units (in parentheses). This applies to papers in data storage. For example, write “15 Gbit/cm2 (100 Gbit/in2).” An exception is when English units are used as identifiers in trade, such as “3½ in disk drive.” Avoid combining SI and CGS units, such as current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for each quantity in an equation.
The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A•m2.”
Figures and Tables
Most authors will be able to prepare images in one of the allowed formats listed above. No matter how you convert your images, it is a good idea to print the files to make sure nothing was lost in the process. For more information on graphics files, please go to www.ieee.org/publications_standards/publications/authors/authors_journals.html and click on the link “Using Microsoft Products or PDFs to Submit Graphics.”
Because IEEE will do the final formatting of your paper, you do not need to position figures and tables at the tops and bottoms of columns. Large figures and tables may span both columns. Place figure captions below the figures; place table captions above the tables. If your figure has two parts, for example, include the labels “(a)” and “(b)” as part of the artwork. Please verify that figures and tables that you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with Arabic numerals.
Color Figures
There is no charge for color figures. Since L-EMCPA is electronic journal, color figures are automatically produced as part of the journal publishing. Please ensure proper choice of colors for unambiguous exposition of what is being shown. 
Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity “Pressure,” or “Pressure, P,” not just “P.” However, if there is not enough room on the axis to specify the quantity, write just the symbol “P,” but define it in the figure caption. IEEE allows two ways to designate units in graphs and tables: (1) Put units in parentheses. As in Fig. 1, for example, write “Intensity (W/m2)” or “Intensity, I (W m-2)” (but not just “W/m2”). (2) Label axes with a ratio of symbols and units. For example, write “Intensity, I/(W m2)” or “Temperature, T/K” (but not “Temperature/K”).
Multipliers can be especially confusing. Write “Frequency (MHz)” or “Frequency (106 Hz).” Do not write “Frequency (Hz)  106” because the reader would not know whether the top axis label in Fig. 1 meant 83,125,000 Hz or 0.000083125 Hz. Figure labels should be legible, approximately 8 to 10 point type when reduced to journal column width.
References[image: ]
Fig. 1.  Resonance frequency as a function of time. Note that “Fig.” is abbreviated. It is good practice to explain the significance of the figure in the caption.
 

L-EMCPA uses a numbered reference style, as in most other IEEE journals. Cite articles by number in square brackets [1]. The sentence punctuation follows the brackets. Multiple references are combined within brackets [1, 2] or [1-4]. When citing a section in a book, please give the relevant page numbers [7]. If the reference is part of the sentence, refer to the authors with the year in brackets, as shown by Eason et al. [3] and Jacobs and Bean [5]. Unfortunately, the IEEE document translator cannot handle automatic endnotes in Word; therefore, type the reference list at the end of the paper using the “References” style. An optional EndNote® style file for L-EMCPA is available here (http://endnote.com/styles/IEEE Trans Biomed Engineer.ens).For journal articles, please include the Digital Object Identifier if you can find it at www.crossref.org/guestquery.
Table 1: Units for Magnetic Properties
Symbol
Quantity a
Conversion from Gaussian and cgs emu to SI b

magnetic flux
1 Mx  108 Wb = 108 V·s
B
magnetic flux density, 
  magnetic induction
1 G  104 T = 104 Wb/m2
H
magnetic field strength
1 Oe  103/(4) A/m
m
magnetic moment
1 erg/G = 1 emu 
   103 A·m2 = 103 J/T
M
Magnetization
1 erg/(G·cm3) = 1 emu/cm3
   103 A/m
4M
magnetization
1 G  103/(4) A/m

specific magnetization
1 erg/(G·g) = 1 emu/g 
   1 A·m2/kg
j
magnetic dipole moment
1 erg/G = 1 emu 
   4  1010 Wb·m
J
magnetic polarization
1 erg/(G·cm3) = 1 emu/cm3
   4  104 T

specific susceptibility
1 cm3/g  4  103 m3/kg

permeability
1  4  107 H/m 
  = 4  107 Wb/(A·m)
r
relative permeability
  r
w, W
energy density
1 erg/cm3  101 J/m3
a No vertical lines in table. 
b Gaussian units are the same as cgs emu for magnetostatics; Mx = Maxwell, G = Gauss, Oe = Oersted, Wb = Weber, V = Volt, s = second, T = Tesla, m = meter, A = Ampere, J = Joule, kg = kilogram, H = Henry.


In the reference list, give all authors’ names; do not use “et al.” Use a space after authors’ initials. Papers that have not been published should be cited as “unpublished” [4]. Papers that have been submitted for publication should be cited as “submitted for publication” [1]. (Since the paper may not be accepted, it is best to not specify the journal.) Papers that have been accepted for publication but not yet assigned to an issue should be cited as “to be published” [2]. Please give affiliations and addresses for private communications [6].
Capitalize only the first word in a paper title, except for proper nouns and element symbols. For papers published in translation journals, please give the English citation first, followed by the original foreign-language citation [8]. 
Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the abstract. Abbreviations such as “IEEE,” “SI,” “ac,” and “dc” do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example, “IEEE” in the title of this article).
Equations
If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (www.dessci.com/en/products/mathtype) for equations in your paper (Insert > Equation). Fit the equation into one column by breaking it as you wish it to appear when typeset. You may find it convenient to create a new “equation” for each section of the equation.
Number equations consecutively with equation numbers in parentheses in the vicinity of the equation, as in (1). To make your equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents. Use parentheses to avoid ambiguities in denominators. Punctuate equations when they are part of a sentence, as in

(1)




The font for symbols should be similar to Times Roman. Use the “Symbol” style. Be sure that the symbols in your equation have been defined either before the equation appears or immediately following. Italicize symbols (T might refer to temperature, but T is the unit Tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the beginning of a sentence: “Equation (1) is ... .”
Please confine equations to one column width and break equations at appropriate algebraic symbols.
Supplementary Information
Authors may not include any supplementary information. The journal’s rapid-publication model requires short articles that can be reviewed relatively quickly and no supplementary material is allowed.
CONCLUSION
A conclusion section is not required. Although a conclusion may review the main points of the paper, do not replicate the abstract in the conclusion. A conclusion might elaborate on the importance of the work or suggest applications and extensions. 
An excellent style manual and source of information for science writers is [9]. A general IEEE style manual is available at www.ieee.org/publications_standards/publications/authors/authors_journals.html. 
ACKNOWLEDGMENT
Only the Acknowledgment and References may extend to this last column on Page 4. The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use the singular heading even if you have many acknowledgments. Avoid expressions such as “One of us (S.B.A.) would like to thank ... .” Instead, write “S.B.A. thanks ... .” This work was supported in part by the U.S. Department of Commerce under Grant BS123456 (sponsor and financial support acknowledgment goes here; spell out the full name of the sponsor).
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